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Organization of This Manual

This manual describes the features, operation and other aspects of the Waveform Analysis Software 

DA-20PA1. To ensure correct and safe operation, be sure to also consult the documentation of the 

computer on which the software is installed. 

The following pages contain important information about safety. Be sure to read and observe these 

in full.

This manual contains the following sections.

Introduction
Provides an outline of the software and describes its features, operating environment, and 

the installation procedure.

Basic Operation
Explains names and functions of elements shown on the main screen, and describes the 

basic operation fl ow.

Advanced Operation
Explains how to select and save fi les, how to display information about different fi le types, 

and how to set data recording parameters for the 4-Channel Data Recorder DA-20.

Other Information
Lists the specifi cations of the software and provides information about WAVE fi le content, 

calibration, troubleshooting, and related items.

* Company names and product names mentioned in this manual are usually trademarks or 

registered trademarks of their respective owners.
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FOR SAFETY

In this manual, important safety instructions are specially marked as shown below. To prevent 

the risk of accidents and damage to the computer on which the software is installed, make

sure that all instructions are fully understood and observed.

Caution

•

Important

•

Note

•

Disregarding instructions printed here incurs 

the risk of injury to persons and/or damage 

to peripheral equipment.

Disregarding instructions printed here incurs 

the risk of operation problems.

Denotes special information that is helpful 

in utilizing the capabilities of the product 

but that is not directly related to safety.

About the Microsoft Windows operating system
This manual does not provide general information on how to use the Microsoft Windows 

operating system. For information about selecting commands and making settings in dialog 

boxes, refer to the documentation and online help of Microsoft Windows.

Examples for computer screens shown in this manual are for illustration purposes only. 

The actual appearance of screens may differ, depending on the version of the Microsoft 

Windows operating system and the computer environment.
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Caution

Do not play the install CD-ROM in a CD player

The DA-20PA1 install disc is not a music CD. Inserting this disc in a CD player poses the risk 

of excessive volume levels that can cause hearing damage and damage to the CD player.
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Important

Check the install CD-ROM

Before inserting the install disc in the CD-ROM drive of a computer, be sure to visually 

check the disc.

If there are any cracks or scratches or if the disc is deformed, do not insert the disc in the

CD-ROM drive. Otherwise there is a risk of damage to the CD-ROM drive.
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Precautions

• If a problem should occur while using this software, contact the supplier with a detailed 

description.

Supported fi le types
The types of fi les that can be handled by this software are listed below.

File format: WAVE (extension “wav”)

File size: Max. 2 GB

Sampling frequency:

240 Hz, 256 Hz, 1.2 kHz, 1.28 kHz, 2.4 kHz, 2.56 kHz, 12 kHz, 12.8 kHz, 

24 kHz, 25.6 kHz, 48 kHz, or 51.2 kHz

Files that do not meet the above specifi cations will not be handled correctly.

This software and the DA-20 support only WAVE fi les that employ the PCMWAVEFORMAT 

structure. WAVE fi les that employ the WAVEFORMATEX structure are not supported.

Some WAVE fi les not created on the DA-20 may not open correctly in this software, due to 

structure differences.

The sampling frequency of a WAVE fi le can be checked in the fi le properties. After import-

ing a fi le, the information can also be checked on the [Wave File &Info] screen.

* WAVE fi les from the DA-20, SA-78WR, and NA-28 (NX-28WR) are supported. Re-

garding the NA-28, fi les with sampling frequencies other than listed above are not 

supported. Use a sampling frequency converter to change such fi les to one of the listed 

sampling frequencies.

WAVE fi le information 
When you change the conversion unit set at the DA-20, the fi le will no longer be playable 

on the DA-20.

When performing an operation such as saving a range of data as a fi le with the intention 

of performing playback on the DA-20, do not change the conversion unit in the WAVE fi le 

information.
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Sampling frequency related limitations
• Depending on the sampling frequency of the WAVE fi le, the available frequency range 

for FFT analysis and octave-band analysis and other items will change.

Sampling
frequency

Playback
Filter where value 

becomes unstable *2

FFT analysis 
upper frequency 

limit *3

Octave-band analysis 
upper frequency limit 

(center frequency)
1/1oct 1/3oct

240 Hz *1 - 93.75 Hz 63 Hz 80 Hz
256 Hz *1 - 100 Hz 63 Hz 80 Hz
1.2 kHz *1 G,Lvxy,Lvz 468.75 Hz 250 Hz 400 Hz

1.28 kHz *1 G,Lvxy,Lvz 500 Hz 250 Hz 400 Hz
2.4 kHz *1 G,Lvxy,Lvz 937.5 Hz 500 Hz 800 Hz

2.56 kHz *1 G,Lvxy,Lvz 1 kHz 500 Hz 800 Hz
12 kHz O G,Lvxy,Lvz 4.688 kHz 2 kHz 4 kHz

12.8 kHz *1 G,Lvxy,Lvz 5 kHz 2 kHz 4 kHz
24 kHz O G,Lvxy,Lvz 9.375 kHz 4 kHz 8 kHz

25.6 kHz *1 G,Lvxy,Lvz 10 kHz 4 kHz 8 kHz
48 kHz O G,Lvxy,Lvz 18.75 kHz 8 kHz 16 kHz

51.2 kHz *1 G,Lvxy,Lvz 20 kHz 8 kHz 16 kHz
Other than 

above
Not supported

*1 Depending on the sound card, CPU speed, and operating system limitations, playback 

may not be possible, or pitch and sound quality may change in playback.

Sound dropouts may occur also in cases marked “O”.

*2 Value after fi lter processing becomes unstable. The abbreviations in the table have the 

following meaning.

G: G characteristics,

Lvxy: Lv horizontal characteristics, Lvz: Lv vertical characteristics

*3 1/2.56 of sampling frequency

• Depending on the sound card and CPU speed of the computer, noise or dropouts may 

occur during playback of a WAVE fi le.

• WAVE fi les with a sampling frequency under 12 kHz may not play. During playback of 

WAVE fi les with a sampling frequency of 12.8 kHz, 25.6 kHz, or 51.2 kHz, the pitch or 

sound quality may change.

DA20.INI fi le setting limitations 
When using a DA20.INI fi le created by this software to save DA-20 settings, make sure 

that there are no confl icts between settings. Otherwise the settings will not become active 

in the DA-20. (For information about setting conditions, refer to the instruction manual of 

the DA-20.)

Install folder precautions 
• Install this software directly on the computer where it is to be used. If the software is 

installed on another computer on a network, correct operation is not assured. 

• Do not delete or change the names of fi les and folders in the installation folder of this 

software. Do not open any fi les in the folder with other applications. Otherwise correct 

operation of the software is not assured.
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Usage License Agreement
I m p o r t a n t

Carefully read and observe the following agreement.

This is a legally binding software license agreement between you as the user and Rion Co., 

LTD. By installing, copying, or using the software, the user agrees to all conditions of the 

agreement. If the user does not agree to any of the conditions of the agreement, the software 

must be returned immediately without using it or any other product associated with it.

The software is protected by national and international copyright laws and regulations and

 intellectual property laws. Rion Co., LTD. only grants the right to use the software. The 

software itself is not sold to the user.

1. License Conditions
(1) Defi nition and Scope

The software covered by this agreement is the Waveform Analysis Software (DA-20 PA1) 

including the media on which the software is supplied, and documentation that is sup-

plied with the software either in printed form or as an electronic fi le. This license 

agreement defi nes the right of the user to use the software.

(2) Usage

The user may install and use the software on one computer that runs a licensed version 

of Microsoft Windows 2000 Operating System, or Microsoft Windows XP Operating 

System. (Microsoft and Windows are trademarks or registered trademarks of Microsoft 

U.S.A. Corporation in the U.S.A. and other countries). For backup purposes only, the 

user may make one (1) copy of the software.

2. Intellectual Property Rights
Rion Co., LTD. only grants the right to use the software. The software itself is not 

sold to the user.

Rion Co., LTD. holds the copyright to the software, and the rights to all copies revert 

to Rion Co., LTD. The user may not remove any copyright or trademark information 

attached to the software.
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3. Limitations
(1) Based on this agreement, the user only acquires the right to use the software.

Any other rights not covered in this agreement are not accorded to the user. The user 

may not copy or otherwise duplicate the software and the associated documentation 

by any means, in whole or in part, except for the case stated in “1. (2) Usage”. The 

software and the associated documentation are protected by copyright laws.

(2) The user does not have the right to give, sell, loan or otherwise make available the 

software and associated documentation to third parties, or to grant any usage rights 

to third parties.

(3) The user does not have the right to alter, decompile, or reverse-engineer the soft-

ware.

(4) The user may not use the software to produce any products that imitate the software. 

Any imitation or simulation of the software is an infringement of copyright laws.

4. Duty of Agreement Propagation
The user must ensure that all persons using the software are fully aware of all condi-

tions of this agreement. Any violation will be the responsibility of the user.

5. Warranty
(1) Rion Co., LTD. guarantees that the software is supplied on media that have no sub-

stantial defect, and that the software contains the functions that are explicitly listed in 

the specifi cations. If the software does not operate according to specifi cations or if any 

problems described above that are the responsibility of Rion Co., LTD. are detected 

and Rion Co., LTD. is informed of this fact within 90 days from the purchase date of 

the software, Rion Co., LTD. will undertake to remedy the problems free of charge.

(2) If the software does not operate according to specifi cations due to causes that are not 

the responsibility of Rion Co., LTD., Rion Co., LTD. will undertake to remedy the 

problems against charge.
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6. Limitation of Warranty
(1) Rion Co., LTD. does not guarantee that the software is fi t for any particular purpose of 

the user, whether stated explicitly or implicitly, or that the software is free of errors.

Rion Co., LTD. does not provide any other kind of warranty except as stated in this 

agreement. Rion Co., LTD. does not accept responsibility for any kind of damage, 

whether direct or indirect, tangible or intellectual, that may arise from the use of the 

software or the failure of the software to perform any function.

(2) Under no circumstances will the responsibility of Rion Co., LTD. as stated in “5. War-

ranty” exceed the equivalent of the price that the user paid for the software.

7. Duration
This agreement is valid until terminated. The user can terminate the agreement at any 

time by destroying the software and associated documentation and deleting all copies 

from the computer where the software was installed. The agreement also terminates

when the user violates any of the conditions herein. In this case, the user also must 

destroy the software and associated documentation and delete all copies from the 

computer where the software was installed.

8. Jurisdiction
Any disputes or litigation arising from this agreement will be under the jurisdiction 

of the Tokyo District Court.
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Introduction
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Outline

The Waveform Analysis Software DA-20PA1 is designed to allow the use of a computer for display 

and playback of waveform data (WAVE format) recorded on a data recorder such as the DA-20.

Features
The software has the following features.

• Display and monitor a waveform and perform analysis of a specifi ed interval.

• Quickly jump to points where voice memo or marker information has been recorded.

• Apply various kinds of frequency weighting (FLAT, A, C, G characteristics) to sound 

level data.

• Apply JIS C1510 compliant frequency weighting to environmental and ground vibra-

tion data collected with a vibration level meter.

• Calculate rms values with various time weighting characteristics (time constant settings).

• Calculate sound exposure level LE, equivalent continuous sound pressure level Leq, 

and percentile sound pressure levels for noise evaluation.

• Calculate the same characteristic values for vibration level evaluation as for sound 

level evaluation.

• Process the recorded waveform with high-pass, low-pass, and bandpass fi lters using 

freely specifi ed cutoff points.

• Perform FFT analysis with 25 to 12800 lines.

• Calculate 1st-order and 2nd-order differentiation and integration spectra from FFT 

analysis results. This function allows for example calculating the velocity or displace-

ment spectrum from the acceleration spectrum.

• Calculate the 1/1 octave and 1/3 octave bandpass spectrum of the recorded waveform.

• Save analysis results as CSV fi les.

• Graph or window copy function facilitates the creation of reports.

All functions of this software become available when the access control key is inserted in a 

USB port of the computer. The key is supplied with the software. The use of hardware-based 

copy-protection is indicated by the “Hard Protect” label on the CD-ROM.

The folder structure on the supplied CD-ROM is as follows.

<Japanese> : Japanese-language operating system folder

<install> : Folder with Japanese-language setup program

<manual> : Folder with Japanese-language documentation

<English> : English-language operating system folder

<install> : Folder with English-language setup program

<manual> : Folder with English-language documentation

CD-ROM
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Operating Environment

This software has the following operating environment requirements.

Operating environment requirements

Computer Intel Pentium IV 2 GHz or equivalent CPU, CD-ROM drive, IBM PC/AT 

compatible architecture

RAM 512 MB or more (when handling WAV fi les larger than 1 GB, installed 

RAM should be 2 GB or more)

Hard disk 10 GB or more of free space

Display Suitable resolution for operating system (1024 × 768, XGA), or equiva-

lent

Operating system (One of the following)

Microsoft Windows 2000 Professional

Microsoft Windows XP Professional

(Support for Japanese and English)

Other requirements 

CompactFlash card slot, speakers, sound card 
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Software Installation

Important 
To install this software, you must be logged on as Administrator 
or as a member of the Administrators group.

Install this software directly on the computer where it is to be 
used. If the software is installed on another computer on a net-
work, correct operation is not assured.

Installing and starting the software 
Perform the installation of the software as follows. For details, see the separate “Installation 

Guide”.

1. Insert the DA-20PA1 CD-ROM into the CD-ROM drive of the computer where the 

software is to be used. Locate the “install” folder under the “English” folder on the 

CD-ROM, and double-click the “setup.exe” icon.
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2. The “Preparing to Install...” screen appears and the installation starts. When installation 

of the DA-20PA1 software is completed, installation of the hardware-based protection 

driver begins.

Follow the instructions that appear on the screen. For details about the setup procedure, 

see the separate “Installation Guide”.

3. Insert the supplied access control key into a USB port of the computer. Verify that the 

LED of the access control key is lit.

Important
Unless the supplied access control key is inserted into a USB 
port of the computer and the LED of the access control key is 
lit, the software will not work. If the key is not inserted or not 
inserted correctly (LED is not lit), an error message will appear 
when trying to start the software.
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4. From the [Start] menu, select [RION] and [DA-20PA1]. The software starts up and 

the main screen appears.

Note
You can also start the software via a shortcut placed on the desktop, 
or by double-clicking “DA-20PA1.exe” located in the folder specifi ed 
during installation.

Note
Start this software from the computer where the software is installed. If 
started from another computer on a network, the software will not operate 
correctly, and error messages such as “Invalid fi le” will appear.
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Troubleshooting

Software does not start properly.
Check the following points and retry the operation. If the software still does not start 

after checking all the points, or if a description of the problem is not found here, contact 

the supplier.

• The hardware-based protection driver may not be installed or not be installed cor-

rectly. Delete the hardware-based protection driver and then install the driver once 

more by double-clicking on “HASPUserSetup.exe” located in the install folder on the 

CD-ROM.

• Check whether the access control key is inserted correctly into a USB port of the 

computer. When the key is inserted correctly, the LED of the key is lit.
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Basic Operation
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Main Screen Part Names and Functions

The various elements of the main screen and their function are briefl y explained in this 

section. 

When you start the software, the main screen appears. 

In the example shown below, there are four graph windows for channels 1 to 4.

Menu bar

Tool bar

File name

Setting panel

Operation panel

Cursor

Graph
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Menu bar
The menu bar gives access to a number of menus, as shown below. Each menu comprises a 

number of commands. 

Commands that are grayed out in a menu have no effect when clicked.

[File] menu
This menu lets you select and save a WAVE fi le, create a DA20.INI 

fi le, and perform other functions. The menu also has commands for 

displaying property information for various fi les.

[File Open]
Selects the WAVE fi le to display. 

For details on how to select fi les, see the section “Selecting a fi le” in “File Operations” 

(page 65). 

[Close]
Closes only the currently displayed WAVE fi le. Does not close the software.

[Save As] 
Saves the displayed data as a WAVE fi le. 

For details on saving fi les, see the section “Saving a specifi ed range” in “File Operations” 

(page 66). 

[Wave File Info] 
Shows information about the displayed WAVE fi le. In the displayed information, the con-

version unit, dB reference, and Calib. (Unit/Volt) settings can be changed. 

For details on the WAVE fi le information, see the section “WAVE fi le information” in 

“File Operations” (page 67). 

[Rion File Info] 
When the displayed WAVE fi le is a Rion fi le, this command shows information about the 

fi le. The memo fi eld can be edited. 

For details on the Rion fi le properties, see the section “Rion fi le information” in “File 

Operations” (page 69). 

[Save DA20INI] 
Creates the DA20.INI fi le that controls the data recording parameters of the DA-20. 

For details on creating a DA20.INI fi le, see the section “Creating a DA20.INI fi le” in “File 

Operations” (page 70). 

[Exit] 
Shuts down the application. The same function can be performed by clicking the  button 

at the top right.
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[Clipboard] menu 
This menu lets you copy a graph or window (screen) to the clipboard. 

[Copy Graph] 
Copies the selected graph to the clipboard. 

[Copy Window] 
Copies the entire screen to the clipboard.

[View] menu 
This menu lets you display or hide the setting panel and operation panel, and control the 

display of statistical information. When all panels are deselected, the graph display fi lls 

the entire screen. 

[Setting Panel] 
Displays or hides the setting panel. 

For details on setting panel operations, see the section “Setting panel” (page 21). 

[Operate Panel] 
Displays or hides the operation panel. 

For details on operation panel operations, see the section “Operation panel” (page 24). 

[RMS Stats. Panel] 
Displays or hides the RMS stats. panel. 

For details on RMS stats., see the section “RMS Stats.” in “Statistical Processing” 

(page 31). 

[Successive RMS Stats. Panel] 
Displays or hides the Successive RMS stats. panel.

For details on the Successive RMS stats. panel, see “Successive RMS Stats.” in the section 

“Statistical Processing” (page 32).

[Wave Stats Panel] 
Displays or hides the waveform stats panel. 

For details on waveform stats, see the section “Waveform Stats” in “Statistical Process-

ing” (page 30).
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[Filter] menu 
This menu lets you make fi lter settings. 

[Filter ON] 
Applies the fi lter according to the settings made on the [Filter Setting] screen to the 

waveform. 

For details on fi lter parameters, see the section "Filter settings" (page 42). 

[Filter OFF] 
No fi lter is applied to the waveform. 

[Filter Setting] 
Brings up the [Filter Setting] screen. 

For details on the [Filter Setting] screen, see the section "Filter settings" (page 42).
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[Analysis] menu 
This menu contains commands for FFT analysis and octave analysis. 

[FFT analysis] 
Brings up the [FFT analysis] screen. 

For details on the [FFT analysis] screen, see the section “FFT Analysis” (page 45). 

[Octave-band analysis] 
Brings up the [Octave-band analysis] screen. 

For details on the [Octave-band analysis] screen, see the section “Octave-Band Analysis” 

(page 55).
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[Graph display range] menu 
This menu contains commands for controlling the graph display. 

The menu items correspond to the tool bar items. For details on the tool bar, see the section 

“Tool bar” (page 18). 

Note 
You can directly specify the display range of the graph using the cur-
sor, or you can use the [Analysis Range] tab on the operation panel. For 
details, see the section “Waveform graph” (page 27).

[Show All] 
Show the entire data as a graph. 

[X Zoom In] 
Enlarge the range specifi ed by the start point and end point on the X axis. 

[X Zoom Undo] 
Return the enlarged analysis range on the X axis to the previous condition. 

[Y Zoom In] 
Enlarge the display range on the Y axis by 25%. 

[Y Zoom Out] 
Reduce the display range on the Y axis by 25%. 

[Move +X] 
Move the specifi ed display range on the X axis by one screen to the right (+ direction). 

[Move -X] 
Move the specifi ed display range on the X axis by one screen to the left (- direction). 

[Move +Y] 
Move the specifi ed display range on the Y axis by about 25% up (+ direction). 

[Move -Y] 
Move the specifi ed display range on the Y axis by about 25% down (- direction). 
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[Player] menu 
This menu contains commands for selecting the channel for playback and for controlling 

playback operations. 

The menu items correspond to the items under the [Player] tab of the operation panel. For 

details on the operation panel, see the section “Operation panel” (page 24). 

[Memo/Marker] 
This item becomes available when voice memo or marker information is contained in the 

data. 

[Pause (Rec)] 
This item becomes available when pause information is contained in the data. 

[Ch1] to [Ch4] 
Lets you select one channel for playback. It is not possible to select multiple channels 

simultaneously. 

[Play] 
Starts data playback. 

[Pause] 
Pauses data playback. Selecting this command during pause cancels the pause condition 

and resumes playback. 

[Stop] 
Stops data playback. 

[RWD] 
Moves the data playback position in the reverse direction (to past data). [Rewind] 

[FF] 
Moves the data playback position in the forward direction (to future data). [Fast-For-

ward]
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[Help] menu 
Provides information about the program version and about protect settings. 

[Version] 
Shows the software version. 
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Tool bar 
Commands for making fi lter settings, starting the analysis screen, and controlling the graph 

display are shown as buttons on this bar. Clicking a button will execute the respective func-

tion. 

Note 
The tool bar becomes available when a fi le is loaded. 

The graph display setting applies to all channels. 

Filter settings/analysis screen buttons 
These buttons give access to the same functions as the [Filter] menu on the menu bar and 

the [FFT analysis] and [Octave-band analysis] commands on the [Analysis] menu. 

 [Filter Setting] button 

Brings up the Filter Setting screen. 

(Same as [Filter] menu) 

 [FFT analysis] button 

Brings up the [FFT analysis] screen. 

(Same as [FFT analysis] command on [Analysis] menu) 

 [Octave-band] button 

Brings up the Octave-band Analysis screen. 

(Same as [Octave-band analysis] command on [Analysis] menu)

Filter settings/analysis screen buttons

Graph display buttons
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Graph display buttons 
These buttons give access to the same functions as the [Graph display range] menu on the 

menu bar. 

 [Show All] button 

Show the entire data as a graph. 

(Same as [Graph display range] menu  [Show All] command) 

 [X Zoom In] button 

Enlarge the range specifi ed by the start point and end point on the X axis. 

(Same as [Graph display range] menu  [X Zoom In] command) 

 [X Zoom Undo] button 

Return the enlarged analysis range on the X axis to the previous condition. 

(Same as [Graph display range] menu  [X Zoom Undo] command) 

 [Y Zoom In] button 

Enlarge the display range on the Y axis by about 25%. 

(Same as [Graph display range] menu  [Y Zoom In] command) 

 [Y Zoom Out] button 

Reduce the display range on the Y axis by about 25%. 

(Same as [Graph display range] menu  [Y Zoom Out] command) 

 [Move -X] button 

Move the specifi ed display range on the X axis by one screen to the left (- di-

rection). 

(Same as [Graph display range] menu  [Move -X] command) 

 [Move +X] button 

Move the specifi ed display range on the X axis by one screen to the right (+ 

direction). 

(Same as [Graph display range] menu  [Move +X] command) 

 [Move +Y] button 

Move the specifi ed display range on the Y axis by about 25% up (+ direction). 

(Same as [Graph display range] menu  [Move +Y] command) 

 [Move -Y] button 

Move the specifi ed display range on the Y axis by about 25% down (- direc-

tion). 

(Same as [Graph display range] menu  [Move -Y] command) 

Note
The [Show All] button applies only to the X axis. The Y axis may extend 
beyond the screen.
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File name 
Shows the fi le name of the displayed data.
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Setting panel 
Gives access to various settings including graph 

display, color, and other items. 

There are three tabs labeled “Graph Display”, “Color”, 

and “Calc. Setting”. Click on the tab to display the 

respective setting items. 

To close the setting panel, click the  (close) but-

ton. 

[Graph Display] tab 
Lets you select the channel to display as a graph. 

[Channel] 
Click the channel that you want to display as a graph. The respective graph display ap-

pears. 
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[Color] tab 
Allows you to specify the color for the graph. 

The color can be specifi ed separately for text, 

cursor 1 (playback start point), cursor 2 (playback 

end point), grid, and the lines representing the 

waveforms of channels 1 to 4. 

Changing the color 
When you click on the item for which you want to change the color, the [Color] window 

appears. Select the desired color and click the [OK] button. 

Note 
By clicking [Defi ne Custom Colors], you can create your own color 
shades.
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[Calc. Setting] tab 
Lets you set the time constant for root-mean-squared (rms) 

value calculation. The time rate for the effective value and 

other items can also be set. 

[LN percentage set] 
The percent fi gure for time percentile level calculation 

can be set from 1 to 99. Specify fi ve fi gures in ascending 

order from left to right. 

[Time Const.] 
The time constant (time weighting) to be used for calculating the rms value can be set for 

each channel separately. 

Click the  button to bring up a list from which to select the setting (1 msec, 10 msec, 

35 msec, FAST (125 msec), 630 msec, SLOW (1 sec)). 

Note 
The time constant setting cannot be lower than 1/2 the sampling interval. 
This is relevant when the sampling frequency is low. 

[Unit] 
Lets you set the graph display Y axis unit for each channel separately. Click the  button 

to bring up a list from which to select the setting. 

Note 
The “V (Volt)” value is calculated using the input range setting active 
when the waveform was recorded on the 4-Channel Data Recorder 
DA-20. Consequently, the value is invalid for WAVE format wave-
form data that were generated or recorded on equipment other than 
the DA-20. 

[Show RMS] 
When this check box is selected, the rms value graph will be shown. Clicking on the box 

will toggle the selection on and off. 

[dB] 
When this check box is selected, the rms value using the measurement quantity unit (EU, 

m/s2, dB, etc.) will be shown on a logarithmic scale. Clicking on the box will toggle the 

selection on and off. 

The check box becomes available when [Show RMS] is selected. 

Note 
The [Unit] setting does not affect this operation.
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Operation panel 
Lets you control data playback operations and specify 

the analysis range. 

By clicking the  (close) button, the operation panel 

can be closed. 

[Play] tab 
Lets you control data playback operations. 

The [Play] menu on the menu bar of the main screen 

gives access to the same functions.
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[Play Channel] 
Selects the channel for playback. Click the  button to bring up a list from which to select 

the setting. 

[PLAY] button 
Starts data playback. 

[PAUSE] button 
Pauses or resume data playback. 

[STOP] button 
Stops data playback. 

[RWD] button 
Moves the data playback position in the reverse direction (to past data). Because this re-

sembles the rewind function on a VCR or similar, the function is called “Rewind”. 

[FF] button 
Moves the data playback position in the forward direction (to future data). Because this 

resembles the fast-forward function on a VCR or similar, the function is called “Fast-

Forward”. 

[BEFORE POINT] button 
This button is available during playback and pause. 

Clicking the button moves the playback position to any preceding voice memo/marker or 

pause point. If there are several such points, the playback position is moved to the closest 

point. 

[NEXT POINT] button 
This button is available during playback and pause. 

Clicking the button moves the playback position to any following voice memo/marker or 

pause point. If there are several such points, the playback position is moved to the closest 

point. 

[Memo/Marker] 
Enabled when there is voice memo or marker information in the data. 

[Pause (Rec)] 
Enabled when there is pause information in the data.
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[Analysis Range] tab 
Lets you specify the data analysis range by setting 

the start position (Start Point) and end position (End 

Point). 

Various data processing functions such as playback 

and FFT analysis are carried out within the range 

specifi ed here. This is particularly useful when there 

is a large amount of waveform data. 

[Start Point]/[End Point] 
The [Start Point] and [End Point] for the analysis range can be specifi ed by any of the 

following methods. 

• Enter a numeric value directly into the fi eld at the right of [Start Point] and [End 

Point]. 

• Click the  or  button at each end of the sliding bar to move the slider and change 

the value in the fi eld at the right of [Start Point] or [End Point]. 

• Drag the slider to change the value in the input fi eld at the right of [Start Point] or 

[End Point]. 

Note 
The analysis range setting applies to all channels. 

The analysis range can also be set by dragging the cursor on the 
waveform graph. The setting made by dragging the cursor and the 
setting made under the [Analysis Range] tab are linked. For informa-
tion on the waveform graph, see page 27. 

[Time Scale] 
Selects how time is expressed. This selection affects the indication of the [Start Point] and 

[End Point], the cursor time, and the time axis of the graph. 

[Elapsed] 
Time is expressed as elapsed time measured from the start of the fi le. 

[Time] 
Time is expressed in terms of when the waveform was stored. 
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Waveform graph 
The selected data are shown as a graph. 

Above the graph, waveform and processing information is shown. Beneath the graph, the 

X axis and Y axis values for the respective cursors are shown. For information on display 

range and analysis range etc., see pages 28 and 29. 

Waveform and processing
information

Start point cursor
(Cursor 1)

End point cursor
(Cursor 2)

Cursor X axis value

Cursor Y axis value



Basic Operation

28

Specifying the analysis range 
You can specify the analysis range by moving the cursors on the graph. The analysis range 

setting applies to all channels. 

1. Drag the start point cursor (cursor 1) from the left edge of the graph towards the right, 

to the desired start point. 

2. Drag the end point cursor (cursor 2) from the right edge of the graph towards the left, 

to the desired end point. 

Note 
The range can also be specifi ed using the [Analysis Range] tab on the 
operation panel. For details, see the section “[Start Point]/[End Point]” 
(page 26). 

Zooming the specifi ed analysis range 
The analysis range specifi ed with the cursors on the graph can be zoomed. 

1. Specify the analysis range with the cursors. 

2. Perform zoom by one of the following two methods. 

• Click the [X Zoom In] button on the tool bar. 

• Use the [Graph display range] menu and select the [X Zoom In] command. 

After zoomBefore zoom



Basic Operation

29

Setting the Y axis display range 
When you double-click on a displayed graph, the “Y-axis Scale 

Setting” screen appears. 

Enter the maximum and minimum values in the respective fi elds 

and click the [OK] button. The Y axis display range will change 

accordingly. To automatically set the display range, select the 

“Auto Scale” check box.

To abandon the setting, click the [Cancel] button. 

You can also change the Y axis display range by right-clicking on the graph and holding the 

mouse button while moving the mouse up or down. 

Other display range settings 
Other display settings can be made by using the [Graph display range] menu or the various 

buttons on the tool bar. 

For details, see the sections “[Graph display range] menu” (page 15) and “Graph display 

buttons” (page 19).
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Statistical Processing 
Various statistical values can be calculated from the data. The available statistical values 

depend on whether time waveform or RMS is selected for display. 

[Waveform Stats] 
The maximum, minimum, average, and variance values are calculated from the time wave-

form data. 

Waveform stats processing 
Processing of waveform statistical values occurs as follows. 

1. Display the time waveform of the data. 

Under the [Calc. Setting] tab, deselect [Show RMS] so that the time waveform is 

shown. 

2. Specify the processing range on the graph or 

by using the [Analysis Range] tab. 

The range should be between 1 and 1000 seconds. 

When the range is set outside of these limits, 

processing is not possible. 

3. Using the [View] menu on the main screen, 

select [Wave Stats Panel]. 

The waveform stats panel appears. 

4. Select the channel for processing. 

The values are calculated and the results are shown. 

* The data used for processing are all sampling data from the analysis range. 

When the fi lter is set to ON, the data after fi ltering are used. 

* If the range is not between 1 and 1000 seconds, processing is not possible. 

* If you have changed the analysis range setting, click the [Calc] button.
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[RMS Stats.] 
The values for time percentile level LN, equivalent level Leq, single-event exposure level LE, 

as well as the maximum level Lmax and minimum level Lmin in the selected range are cal-

culated. If [Save As] is used to save the selected range as a CSV fi le, the processing results 

are output to the fi le.

RMS stats. processing 
Processing of RMS statistical values occurs as follows. 

1. Display the time waveform of the data. 

Under the [Calc. Setting] tab, select [Show RMS] so that the RMS indication is shown. 

2. Specify the processing range on the graph or by using the [Analysis Range] tab. 

The range should be between 1 and 3600 seconds. When the range is set outside of 

these limits, processing is not possible. 

3. Using the [View] menu on the main screen, 

select [RMS Stats. Panel]. 

The RMS stats. panel such as shown at right 

appears. 

4. Select the channel for processing. 

5. The values are calculated and the results are 

shown. 

* The data used for processing are sampled 

every 10 milliseconds for RMS calcula-

tion. When the fi lter is set to ON, the 

data after fi ltering are used. 

* The range should be between 1 and 3600 seconds, and the number of data 

points should be no more than 1 million.

* If RMS is not calculated, the indication “Disabled” is shown in the Lmax and 

Lmin fi elds.

* Regardless of whether “dB” is selected or not, the values are always calculated as dB. 

* Precision at lower levels will be reduced. 

For example, for a -60 dB signal, precision is approx. 1 dB. 

* If you have changed the analysis range setting, click the [Calc] button.

* The [RMS Stats. Panel] command on the [View] menu of the main screen is 

only enabled when the “Show RMS” check box is selected.

* In the processing result, Leq may exceed Lmax in a certain period. Lmax is the maxi-

mum value of the sound pressure level for the time domain waveform with time 

weighting (Fast, Slow, etc.), calculated by exponential averaging. On the other 

hand, Leq is determined from the time domain waveform in the specifi ed period, 

but exponential averaging is not applied. Therefore Leq may exceed Lmax for periods 

where the level determined by exponential averaging is not yet suffi ciently high.
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Saving the processing result 
To save the processing result values, proceed as follows. 

1. On the [File] menu of the main screen, select [Save As]. 

2. Specify “*.csv” as fi le type. 

3. Specify the folder and fi le name and click the [OK] button. 

The statistical values for the selected range will be saved as a CSV fi le.

[Successive RMS Stats.]
RMS processed data are divided into multiple periods, and 

for each period the equivalent level Leq, and maximum level 

Lmax are calculated.

1. Enter the period duration and select the time unit (hours, 

minutes, seconds).

2. When you click the [Calc] button, a “Successive RMS 

Stats. Results” screen such as shown below appears.

* The [RMS Stats. Panel] command on the [View] menu of the main screen is only 

enabled when the “Show RMS” check box is selected.
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Saving the processing result
To save the processing result values, proceed as follows.

1. Click [Export] on the “Successive RMS Stats. Results” screen.

2. Specify “*.csv” as fi le type.

3. Specify the folder and fi le name and click the [OK] button.

The statistical values for the selected range will be saved as a CSV fi le.
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Operation Flow

This software has two kinds of usage applications. The fi rst usage is to check and display 

waveform data that were recorded with the DA-20 and to save such data on the computer as 

required, in a specifi c fi le format. The second usage is for checking and setting recording 

parameters used by the DA-20 and to write such parameter settings to a CompactFlash card 

for use in the DA-20. 

This section provides a brief outline of each usage type. For detailed steps, refer to the re-

spective sections on the pages indicated. 

I. Checking and saving waveform data 

1. Select the fi le whose data you want to check and save (see page 65). 

On the menu bar, access the [File] menu and select [File Open]. The “File Open” 

screen appears. Select the desired fi le. 

From this screen, you can also play back the selected fi le using the Player panel at the 

top right of the screen.
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2. Use tool bar and the setting panel to display the waveform data and check the contents 

(see pages 18 to 19 and 21 to 23). 

3. Save the data. 

Using the original data, you can specify a range and save it as a new fi le (see 

page 66). 

You can also copy the display contents into the clipboard, for saving as a bmp fi le or 

for pasting into a document or other application (see page 12).
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II. Writing a setting fi le to a CompactFlash card for use in the DA-20 
You can set the recording conditions of the DA-20 using this software. The procedure is as 

follows. 

Note 
For details on recording conditions, refer to the documentation of the 
DA-20. 

1. In the formatting menu of the computer, select “FAT” as the fi le system. 

Important 
Do not select a fi le system other than FAT (such as FAT32 etc.). 
CompactFlash cards that have been formatted using a fi le sys-
tem other than FAT (such as FAT32 etc.) cannot be used in the 
DA-20. 

2. Format the CompactFlash card.

3. Open the [DA20INI Settings] screen.

To open this screen, access the [File] menu on the menu 

bar and select [Save DA20INI].

The [DA20INI Settings] screen opens.
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4. Change the settings as desired and write the result to the CompactFlash card for use 

in the DA-20. For information about the relationship between setting items and DA-20 

operation, see page 70. 

When the settings have been changed, save the DA20.INI fi le. 

From the [DA20INI Settings] screen, select [Save As] and enter “DA20.INI” as the 

fi le name. 

Important 
Files with names other than “DA-20.INI” will not be recognized 
by the DA-20 and the unit will not operate. 

Note 
If WAVE fi les are also to be stored on the CompactFlash card, write the 
DA-20.INI fi le fi rst as described above, and then follow the instructions 
in “Copying data to CompactFlash card for playback in DA-20” (page 38) 
from step 3 to write the WAVE fi les to the card.
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Copying data to CompactFlash card for playback in DA-20 
To copy data onto a CompactFlash card for playback with the DA-20, proceed as follows. 

Note 
The explanation assumes that there are data fi les on the computer that 
you want to play back with the DA-20. 

1. In the formatting menu of the computer, select “FAT” as the fi le system. 

Important 
Do not select a fi le system other than FAT (such as FAT32 etc.). 
CompactFlash cards that have been formatted using a fi le sys-
tem other than FAT (such as FAT32 etc.) cannot be used in the 
DA-20. 

2. Format the CompactFlash card. 

3. Create a folder named “WAVEFILE” on the hard disk of the computer, for example 

on the desktop. 

4. Copy the data fi le(s) to be used for playback on the DA-20 into this folder. The fi le 

names must conform to the D*****.WAV format as specifi ed for the DA-20. 

Note 

• The “*****” is an alphanumeric string of fi ve characters. 

• Copy fi les in sequence into the folder, starting with lower “*****” 

values. 

• Use only data fi les that were recorded with the DA-20 or fi les 

that were created with the DA-20PA1 software by specifying 

and saving a range. Other kinds of WAVE fi les will not contain 

Rion fi le information and can therefore not be played on the 

DA-20.
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5. Copy the entire “WAVEFILE” folder to the CompactFlash card in one operation, using 

a suitable tool of the operating system (such as Explorer). 

Important 
Any of the following actions will cause all data on the Com-
pactFlash card to become unplayable by the DA-20. If such an 
action was carried out by mistake, back up the data from the 
CompactFlash card onto the computer and then perform the 
above procedure once more from the beginning. 

• A data fi le on the CompactFlash card was deleted by a 

device other than the DA-20. 

• A data fi le on the CompactFlash card was overwritten by 

a device other than the DA-20. 

• Files from the “WAVEFILE” folder were copied onto the 

CompactFlash card individually (not as the entire fold-

er). 

• The “WAVEFILE” folder was copied onto the CompactFlash 

card without formatting the card fi rst. 

• A fi le of another application was written to the Compact-

Flash card. (Even deleting such a fi le will not solve the 

problem.)

When playback on the DA-20 is completed, be sure to either 
delete all contents of the CompactFlash card or format the card. 
If copied data remain on the CompactFlash card, later recording 
may not be performed properly.
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Filter Settings

The time waveform data can be processed by fi lters with various frequency weighting char-

acteristics. In addition to fi lters with preset characteristics, an arbitrary fi lter with user-speci-

fi ed cut-off frequency settings can also be selected. The fi lter characteristics are shown on 

the screen as a graph.

Note
Certain limits apply to available arbitrary fi lter settings.
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[Channel select] combo box 
Selects the channel to which the fi lter is applied. Each channel can have a different fi lter 

setting. 

[Filter Characteristics] radio buttons 
Seven fi lter selections are available via radio buttons: FLAT, A-weighting, C-weighting, 

G-weighting, Lvz-weighting, Lvxy-weighting, Arbitrary Filter. 

[Arbitrary Filter] tab 
The settings made under this tab become active when “Arbitrary Filter” is selected for 

[Filter Characteristics]. 

[Arbitrary fi lter type] radio buttons 
Available selections are high-pass fi lter, low-pass fi lter, and bandpass fi lter. Then select 

the cut-off frequency (Hz). 

[Cut-off Frequency] input fi elds 
Cut-off Frequency 1: Low-side cut-off frequency 

Cut-off Frequency 2: High-side cut-off frequency 

[dB/Oct] combo box 
Select the attenuation slope from 6, 12, 18, 24 dB/octave. 

[LogY] check box 
Causes the frequency characteristics graph Y axis to be shown in dB. 

[LogX] check box 
Causes the frequency characteristics graph X axis to be shown as a logarithmic indica-

tion. 

[OK] button 
Activates the current setting and closes the Filter Setting screen. 

[Cancel] button 
Closes the Filter Setting screen.
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To set up the fi lter, proceed as follows. 

1. Select the channel for which to make the fi lter setting. 

2. Select the fi lter characteristics. 

The selected fi lter appears as a graph. 

When you have selected “Arbitrary Filter”, make the following settings. 

 (1) Select high-pass fi lter/low-pass fi lter/bandpass fi lter. 

 (2) Enter the cut-off frequencies. 

 (3) Select the attenuation slope (dB/octave). 

3. To accept the settings, click the [OK] button. 

The settings become active, and the Filter Setting screen closes. 

To close the Filter Setting screen without accepting the settings, click the [Cancel] 

button. 

4. Specify the range to which you want to apply the fi lter. The range can be specifi ed 

directly on the graph or by using the [Analysis Range] tab. 

5. Using the [Filter] menu on the main screen, set the fi lter to ON. 

Filter processing is carried out, and the range processed by the fi lter is automatically 

zoomed. 

To cancel fi lter processing, click the [Stop] button. In this case, the fi lter range extends 

to the point where the [Stop] button was clicked. 

Note 
If the [Show RMS] check box under the [Calc. Setting] tab on the main 
screen is selected, the fi lter cannot be selected. 

* If you change the fi lter settings or display range, fi lter processing is carried out 

again. 

* FFT analysis, octave-band analysis, and statistical value processing are carried out 

using the results of fi lter processing. 

* To disable the fi lter, select [Filter OFF] from the [Filter] menu on the main screen. In 

this case, the results from FFT analysis, octave-band analysis, and statistical process-

ing are discarded. 

* If the cut-off frequency is set to a low value with regard to the sampling frequency and 

frequency range (for example, less than 10 Hz for a sampling frequency of 48 kHz), 

proper cut-off characteristics will not be achieved. Although the indication on the Filter 

Setting screen will show the cut-off, in actual operation correct attenuation does not 

apply.
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FFT Analysis

The software enables FFT analysis of the range selected at the main screen. The amplitude 

spectrum will be displayed. 

• The waveform range shown on the FFT analysis screen covers the analysis range set 

on the main screen, i.e. the range between the start point and end point. 

• When the fi lter was applied to the waveform on the main screen, the [FFT analysis] 

screen will also show the result of fi lter processing.
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Menus 

[File] menu 

[File Save] 
Saves the result of one FFT analysis shown on screen as a CSV fi le. 

• Data for all channels are saved in a single fi le. 

• Also if zoom or move was performed, the FFT analysis result from before the action 

will be saved. 

[Close] 
Closes the [FFT analysis] screen. 

[Clipboard] menu 

[Copy Graph] 
Copies the FFT graph to the clipboard. Proceed as follows. 

1. On the FFT graph, click within the area of the channel that you want to copy. 

2. Click [Copy Graph] on the [Clipboard] menu. 

The graph is copied to the clipboard. 

[Copy Window] 
Copies the entire [FFT analysis] screen to the clipboard. 

[View] menu 

[Setting panel] 
This menu lets you display or hide the setting panel. 

• You can also turn off the setting panel with the  button in the panel.
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Setting panel 
Lets you make settings for analysis channel, analysis conditions, colors etc. 

[Graph] 
Lets you select the channels to show on screen. FFT analysis is performed for all channels 

for which a check mark is placed in the box. 

[Color] 
• Lets you specify the colors for background, text, cursor, grid, and channels 1 to 4. 

• Channels 1 to 4 are the colors that will be used for Ch1 to Ch4 on the FFT analysis 

graph. 

• The time waveform color will be the same as set on the main screen. This specifi ca-

tion cannot be made on the [FFT analysis] screen.
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[Setting] 
Lets you specify the parameters for FFT analysis. 

Time Window:

Hanning, Flat-top, Rectangular 

Sample N: 64/ 128/ 256/ 512/ 1024/ 2048/ 4096/ 8192

/ 16384/ 32768 

Averages: 1 to 1024 

Overlap Rate :

0%/ 25%/ 50%/ 75% 

Overlap Samples:

Calculated as Sample N × Overlap Rate 

The following limitations apply for the FFT setting parameters. 

If the specifi ed analysis point number as determined by sample number, averaging 

count, and overlap rate (overlap samples) exceeds the displayed time waveform data 

range, click the [Start Point] button to automatically adjust the averaging count to 

the maximum value that fi ts the available analysis range. 

Sample number

Available analysis range

Specified analysis point number (exceeds time waveform data)
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The maximum value for the averaging count is calculated according to the following for-

mula. 

N=(St-S0)/(Sa-S0) (discard decimal points for the quotient) 

N: Maximum averaging count 

St: Sample number of time waveform data 

Sa: Sample number 

S0: Overlap samples 

Example 1 
Sample number of time waveform data:

100000 

Sample number: 512 

Averaging count: 200 

Overlap rate: 0% 

(Overlap samples: 0) 

In this case, the actually used averaging count becomes 195. 

Example 2 
Sample number of time waveform data: 100000 

Sample number: 512 

Averaging count: 300 

Overlap rate: 25% 

(Overlap samples: 128) 

In this case, the actually used averaging count becomes 260. 

• When the overlap rate is changed, the number of overlap samples is automatically 

calculated.
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[Channel specifi c settings]
These items can be set individually for each channel. After clicking on the button for the 

desired channel, make the settings as required. 

Frequency weighting 
Clicking here lets you select from the following options:

A-weighting, C-weighting, G-weighting, Lvz-weighting, Lvxy-

weighting, None. 

This selection is available only when the fi lter setting on the 

main screen is OFF or when it is ON and “FLAT” has been 

selected. At other fi lter settings, the frequency weighting here 

is fi xed to “None”. 

Derivative/Integration
Clicking here lets you select from the following options: None, differential of 1st-order, 

differential of 2nd-order, integral of 1st-order, integral of 2nd-order.

dB 
When this check box is selected, the FFT analysis result is shown in dB. 

peak 
FFT analysis result is shown as peak values.

rms 
FFT analysis result is shown as rms values.

Note

• About rms and peak values
When performing FFT analysis of y(t) = Asin2 π ft + B signal (where 
(single) amplitude A, offset B), the rms value is always 3 dB lower 
than the peak value, except at 0 Hz.

• rms setting
Value at 0 Hz: B
Value at f Hz: A/√2

• peak setting
Value at 0 Hz: B
Value at f Hz: A
Overall value (OA) in both cases does not comprise DC (0 Hz).
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[Target] 

Each CH 
The display iteration count can be specifi ed for each channel. 

The boxes for count and averaging on the graph become avail-

able. 

All CH 
The display iteration count is the same for all channels. The boxes for specifying the count 

and averaging for all channels become available. 

Count for all channels 
Lets you specify the display iteration count for all channels. 

Averaging check box 
Lets you select average indication for all channels. This averaging count applies to the 

total number of all analysis iterations (not the average of the displayed count).
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Redraw 
When the analysis range was changed on the main screen or a fi le was 

reopened, click the [Redraw] button on the [FFT analysis] screen to up-

date the waveform indication on the [FFT analysis] screen. 

When you redraw the screen, the previous analysis result will be cleared. Click the [Start] 

button to restart the analysis. 

Analysis procedure 
Clicking the [Start] button initiates FFT analysis processing. 

When analysis up to the specifi ed averaging count has been performed, the procedure stops 

automatically. 

During analysis processing, the [START] button changes to [STOP]. By clicking the button, 

you can stop the process before completion. 

When analysis processing is completed, the averaged results are shown. 

[Analysis upper limit frequency] 
With this software, the upper limit frequency for analysis is set to 1/2.56 of the sampling 

frequency of the waveform data. The table below shows the frequencies for various sampling 

frequencies. 

Sampling frequency Analysis upper limit

240 Hz 93.75 Hz

256 Hz 100 Hz

1.2 kHz 468.75 Hz

1.28 kHz 500 Hz

2.4 kHz 937.5 Hz

2.56 kHz 1 kHz

12 kHz 4.6875 kHz

12.8 kHz 5 kHz

24 kHz 9.375 kHz

25.6 kHz 10 kHz

48 kHz 18.75 kHz

51.2 kHz 20 kHz
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Analysis result display 

[Analysis count] 
You can specify any count for display here, up to the actual number 

of analysis iterations that were performed. 

When the [Avrg] check box is selected, the results for the total averaging count are averaged. 

(This is not the average for the counts currently displayed.) 

This setting is not available when the [Target] item is set to “All CH”. 

[Analysis information] 
Information about the window function, sample number, 

differential/integral setting, and frequency weighting 

characteristics is shown here.
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[Y-axis Scale Setting] 
When you double-click on the FFT analysis graph for a 

channel, the dialog box for setting the Y axis scale appears, 

letting you set the maximum and minimum values. 

When the FFT analysis function was started, the Y axis 

scale is normally resized automatically for each display. 

When the check box is deselected and Y axis scale set-

tings are made, the Y axis scale becomes fi xed.

[X-axis Scale Setting] 
When you right-click on the FFT analysis graph for a 

channel, the dialog box for setting the X axis scale appears, 

letting you set the maximum and minimum values.

When the FFT analysis function was started, the scale is 

normally resized automatically for each display. When 

the “All” check box is deselected and X axis scale set-

tings are made, the X axis scale becomes fi xed. The 

bar graph (AP) at the right side of the graph also is no 

longer displayed.

[Graph Zoom/Move/Return]
When you click the left mouse button somewhere on the FFT graph and then hold the but-

ton down while dragging the mouse from left to right, the dragged rectangular area will be 

displayed in enlarged view. 

When you click the right mouse button somewhere on the FFT graph and then hold the but-

ton down while dragging the mouse, the graph will move in the same direction. 

When you click the left mouse button somewhere on the FFT graph and then hold the button 

down while dragging the mouse from right to left, the zoomed or moved FFT graph will 

return to the original condition. 

[Cursor] 
A cursor is shown on the FFT graph, and the frequency at the cursor point is indicated. 

The cursor can be moved on the FFT graph by using the move buttons ( ) on the screen. 

[Link Time Waveform Graph and FFT Graph] 
The cursor on the time waveform can be moved sideways by grasping it with the mouse. When 

you do this, the FFT graph also changes to show the result for the current time point. 

Selecting the [xlog] check box switches the frequency axis to a logarithmic scale. 

Saving the analysis result 
You can store the FFT analysis result as a CSV fi le. 

For details, see the section [File] - [File Save] (page 46).
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Octave-Band Analysis 

The software enables 1/1 octave-band and 1/3 octave-band analysis of the range selected at 

the main screen. 

[Compatible sampling frequencies] 
This software can only perform octave-band analysis on waveform data using the following 

sampling frequencies (the same as available on the DA-20). 

240 Hz, 256 Hz, 1.2 kHz, 1.28 kHz, 2.4 kHz, 2.56 kHz, 12 kHz, 12.8 kHz, 24 kHz, 

25.6 kHz, 48 kHz, 51.2 kHz 

• For data with sampling frequencies other than the above, an error message will appear 

when you click the [Start] button on the [Octave-band Analysis] screen, but the time 

waveform can be displayed. 

• When you open the [Octave-band Analysis] screen, the range will be the same as set 

on the main screen, i.e. the range between the start point and end point. 

• When the fi lter was applied to the waveform on the main screen, the [Octave-band 

Analysis] screen will also show the result of fi lter processing.
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Menus 

[File] menu 

[File Save] 
Saves the result of the octave-band analysis as a CSV fi le. 

The currently displayed octave-band data or all octave-band data can be saved. 

To save a fi le, proceed as follows. 

1. Access the [File] menu and select [Save]. The save dialog appears. 

2. Select the data to save. 

3. Click the [Save] button. The fi le dialog box appears. 

4. Specify the folder and fi le name and click the [Save] button. The fi le is saved. 

Note 
Data for all channels are saved in a single fi le. 

[Clipboard] menu 

[Copy Graph] 
Copies the octave-band graph to the clipboard. Proceed as follows. 

1. Click on the octave-band graph for the channel that you want to copy. The area with 

the clicked channel is shown recessed. 

2. Click [Copy Graph] on the [Clipboard] menu. 

The graph is copied to the clipboard. 

[Copy Window] 
Copies the entire [Octave-band Analysis] screen to the clipboard. 

[View] menu 

[Setting panel] 
This menu lets you display or hide the setting panel. 

You can also turn off the setting panel with the  button in the panel.

[Stats panel]
Displays or hides the statistics panel.

You can also turn off the statistics panel with the  button in the panel.
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Setting panel
Lets you make settings for analysis parameters, graph display, colors etc. 

[Graph] 
Lets you select the channels to show on screen. Octave-band 

analysis is performed for all channels for which a check mark 

is placed in the box. 

[Color] 
Lets you specify the colors for background, text, cursor, grid, 

and channels 1 to 4. 

Channels 1 to 4 are the colors that will be used for Ch1 to Ch4 

on the octave-band analysis graph. 

The time waveform color will be the same as set on the main 

screen. This specifi cation cannot be made on the [Octave-band 

analysis] screen.
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[Setting] 
Lets you specify the parameters for octave-band analysis. 

1/N octave: 1/1 octave, 1/3 octave 

Based on the sampling frequency of the waveform data, the upper limit for the analysis 

frequency band differs. The analysis graph will display data up to this frequency band. 

See the following table for more information. 

Sampling 
frequency

1/1 octave analysis 
upper frequency limit

1/3 octave analysis 
upper frequency limit

240 Hz 63 Hz 80 Hz

256 Hz 63 Hz 80 Hz

1.2 kHz 250 Hz 400 Hz

1.28 kHz 250 Hz 400 Hz

2.4 kHz 500 Hz 800 Hz

2.56 kHz 500 Hz 800 Hz

12 kHz 2 kHz 4 kHz

12.8 kHz 2 kHz 4 kHz

24 kHz 4 kHz 8 kHz

25.6 kHz 4 kHz 8 kHz

48 kHz 8 kHz 16 kHz

51.2 kHz 8 kHz 16 kHz
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Interval: Specifi es the waveform data update interval for analysis. The setting range is 

5 milliseconds to 3600 seconds. The unit can be switched between seconds 

(sec) and milliseconds (msec). 

Depending on the sampling frequency of the waveform data, the minimum 

setting value may be higher than 5 milliseconds. See the following table for 

more information. 

Sampling frequency Display interval minimum setting

240 Hz 25 msec

256 Hz 125 msec

1.2 kHz 5 msec

1.28 kHz 25 msec

2.4 kHz 5 msec

2.56 kHz 25 msec

12 kHz 5 msec

12.8 kHz 5 msec

24 kHz 5 msec

25.6 kHz 5 msec

48 kHz 5 msec

51.2 kHz 5 msec

The interval is always an integral multiple of the minimum setting. If another 

value is entered, it is automatically adjusted.
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Example: minimum setting 5 msec
Available interval settings are 5, 10, 15 msec etc. 

If “12 msec” is entered, the setting is automatically adjusted to “15 msec”. 

In actual analysis, the interval setting will not be applied rigidly. Rather, for each interval, 

the closest preceding sample will be used. 

Stop Count:

Sets the number of data used for analysis, from 1 to 1000. When the result 

of “interval x stop count” exceeds the number of waveform data, an error 

message will appear when you click the [Start] button. The message will 

indicate the possible setting range for the current interval setting. Change 

the setting accordingly. 

Available analysis range

Interval x stop count (exceeds time waveform data)

Interval

Time Const:

1 msec/10 msec/35 msec/125 msec/630 msec/1000 msec/10 sec 

The time constant can be set separately for each channel. Click the respective 

channel button and then make the setting.
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[Channel specifi c settings]
These items can be set individually for each channel. After clicking on 

the button for the desired channel, make the settings as required. 

Frequency weighting 
Clicking here lets you select from the following options: 

A-weighting, C-weighting, G-weighting, Lvz-weighting, Lvxy-weighting, FLAT. 

This selection is available only when the fi lter setting on the main screen is OFF or when 

it is ON and “FLAT” has been selected. At other fi lter settings, the frequency weighting 

here is fi xed to “None”. 

The waveform data condition can be checked on the waveform graph and from the pro-

cessing information. 

dB 
When this check box is selected, the octave-band analysis result is shown in dB. 

[Target] 

Each CH 
The count can be specifi ed for each channel. The boxes for count 

and averaging on the graph become available. 

All CH 
The count is the same for all channels. The boxes for specifying the count and averaging 

for all channels become available. 

Count for all channels 
Lets you specify the count for all channels. 

Averaging check box 
Lets you select average indication for all channels. This averaging count applies to the 

total number of all analysis iterations (not the average of the displayed count).
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Redraw 
When the analysis range was changed on the main screen, click the [Redraw] 

button on the [Octave-band analysis] screen to update the waveform indi-

cation.

Analysis procedure
Clicking the [Start] button initiates analysis processing. 

When analysis up to the specifi ed averaging count has been performed, the procedure stops 

automatically. 

During analysis processing, the [START] button changes to [STOP]. By clicking the button, 

you can stop the process before completion. 

When analysis processing is completed, the averaged results are shown, using rms values.

* When the statistics panel command on the [View] menu is checked, the setting panel 

becomes as follows.

 
: Selects percentile level. Available settings are L5, L10, L50, L90, 

and L95.

Percentile level such as L5 and L95 can only be selected if the sta-

tistical quantity which is in bottom left of the graph is set to LN.

 : Lets you export the processing result.

 : Closes the statistics panel.



Advanced Operation

63

 : Selects the statistical quantity. Available settings are Leq, LE, Lmax, LN, 

and instantaneous value.

Analysis result display 

[Analysis count] 
You can specify any count for display here, up to the actual number of 

analysis iterations that were performed. 

When the [Save Stored Data] check box is selected, the results for the total averaging count 

are averaged. (This is not the average for the counts currently displayed.) 

This setting is not available when the [Target] item is set to “All CH”. 

[Analysis information] 
Information about the analysis result time and frequency weighting 

characteristics are shown on the graph.

* When the statistics panel command on the [View] menu is checked, the indication on 

the bottom left of the graph becomes as follows.
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[Scale Setting] 
When you double-click on the analysis graph for a channel, 

the dialog box for setting the scale appears, letting you set 

the display range. 

Freq. display range: 

When this check box is selected, frequency 

bands under 20 Hz are not displayed. 

Max/Min: 

These boxes let you specify the maximum value and minimum value for the 

Y axis display scale. 

When the analysis function was started, the Y axis scale is normally resized 

automatically for each display. When settings are made as described here, 

the Y axis scale becomes fi xed. 

When the Auto Scale check box is selected, the Y axis is scaled automati-

cally.

[Cursor] 
A cursor is shown on the analysis graph, and the frequency at the cursor point is indicated. 

The cursor can be moved on the analysis graph by using the move buttons ( ) on the 

screen. 

[Link Time Waveform Graph and Analysis Graph] 
The cursor on the time waveform can be moved sideways by seizing it with the mouse. When 

you do this, the analysis graph also changes to show the result for the current time point. 

Saving the analysis result 
You can store the analysis result as a CSV fi le. 

For details, see the section [File] - [File Save] (page 56).
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File Operations 

This section describes how to select fi les for analysis, how to save a specifi ed range, how to 
display information about various fi les, and how to set the data recording parameters for the 
4-Channel Data Recorder DA-20. 

Selecting a fi le 
Select a WAVE fi le for display as follows. 

1. From the [File] menu, select the [File Open] command. 
The [File Open] screen appears. 

2. From the list of drives, select the drive where the fi le to be analyzed is located. Click 
the  button to bring up a list from which to make the selection. 
A list of folders on the selected drive appears in the folders window. 

3. From the list of folders, select the folder where the fi le to be analyzed is located. 
A list of fi les in the selected folder appears. 

Note 
When you move the pointer to a fi le and click on it, the waveform playback 
panel becomes active, allowing you to check the content of the fi le. For 
information on how to use the waveform playback panel, see the section 
“Operation panel” (page 24). 

Files that are not in a format that can be opened by the DA-20 will not 
be displayed, even if they are WAVE fi les.

4. Click the [Open] button. 
The selected fi le is loaded.

Important
If you start the DA-20PA1 program and attempt to open a fi le, but 
no WAVE fi le is present in the directory, the indication “Selected 
fi le not found” appears.
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Saving a specifi ed range
The data of a specifi ed range can be saved as a WAVE fi le or text (.CSV) fi le. “Specifi ed 

range” refers to the area between the start point and end point cursors. 

1. From the [File] menu, select the [Save As] command. 

The [Save As] screen appears. 

2. In the [Save in] fi eld, select the target drive or folder. Click the  button to bring up 

a list from which to make the selection. 

The folders in the selected drive/folder are shown. 

3. Select the target folder from the folder/fi le list. 

4. Enter the name of the fi le to be created in the [File name] fi eld. The [Save as type] 

fi eld lets you select either “.WAV” or “.CSV”. 

5. Click the [Save] button. 

Note 
When the fi le has been saved correctly, a message to that effect is dis-
played. 

When saving CSV fi les, voice memo/marker information and pause 
information (count, time, size) will not be saved.
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WAVE fi le information
Information about the currently open WAVE fi le (number of channels, sampling frequency, 

etc.) can be displayed. On this display, the Conv. Unit, dB Reference, and Calib. (Unit/Volt) 

can be changed.

Important 
When you change the Conv. Unit set at the DA-20, the fi le will no 
longer be playable on the DA-20. When saving a range of data as 
a fi le with the intention of performing playback on the DA-20, do 
not change the conversion unit in the WAVE fi le information.

The Calib. information is saved for multiple channels together. 
When applying to load Calib. information to a fi le with more 
channels than the original fi le for which the Calib. information 
was saved (for example, applying the Calib. information of a 
1-channel WAVE fi le to a 4-channel WAVE fi le), an error mes-
sage may appear. In such a case, note the Calib. setting and 
enter it again.

1. From the [File] menu, select the [Wave fi le Info] command.

The [Wave fi le &Info] screen appears.

Note 
Recorded data created with the 4-Channel Data Recorder DA-20 con-
tain Rion specifi c information about Conv. Unit, dB Reference, Calib. 
(Unit/Volt), etc. When this information is not present, the default values 
are shown.
For details regarding settings, see “About the Calibration Function 
(Read-out Conversion)” on page 82.
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2. Change the [Conv. Unit], [dB Reference], and [Calib. (Unit/Volt)] fi elds as required.

Note 
By clicking the [Apply] button after changing a setting, you can make 
the change effective immediately.

3. Save the [Conv. Unit], [dB Reference], and [Calib. (Unit/Volt)] information for each 

channel, as required. When you press the [SET] button, a [Memory 1], [Memory 2], 

and [Memory 3] button will appear. You can save the settings by clicking one of these 

buttons. Saved settings can be called up by using the [LOAD] button.

4. To terminate the fi le information view/change procedure, click the [OK] button.
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Rion fi le information
Recorded data created with the 4-Channel Data Recorder DA-20 contain Rion specifi c in-

formation about various items. Memo information can also be entered or edited.

1. From the [File] menu, select the [Rion File Info] command.

The [Rion File Info] screen appears.

2. Enter or change the memo information as required (max. 32 characters).

3. To terminate the Rion fi le information view procedure, click the [OK] button.
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Creating a DA20.INI fi le
The DA-20PA1 software allows you to control the data recording parameters of the DA-20. 

For information about parameter settings, consult the DA-20 Instruction Manual.

1. From the [File] menu, select the [Save DA20INI] command.

The [DA20INI Settings] screen appears.

2. Change the various settings as required.

The available setting items as they appear on this screen and the corresponding DA-20 

parameter are listed below.

Freq.Range Frequency range

Samp.Freq Sampling frequency and frequency range ratio

(sampling frequency/frequency range)

Rec.Time.Unit Recording time unit (hours/minutes/seconds)

Rec.Time.Value Recording time value

VoiceMemo Voice memo function

TriggerMode Trigger operation mode

TriggerType Trigger signal type

Pre-Time Pre-recording time

TriggerLevel Trigger level

Trigger.Ch Trigger channel

Light Auto Off Backlight timer

PlayMode Playback mode

LCD Contrast Display contrast

ID ID number
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The following setting items can be set for each channel separately. 

If the check box [Apply the same settings for all channels] is selected, all channels 

will use the settings made for channel 1. Note that simply deselecting this check box 

will not restore the original settings in the other channels. 

Input Sensor type

Range Input range

HPF High-pass fi lter

LPF Low-pass fi lter

Sensor Sensor type and unit

Sen. Sensitivity and unit conversion

The following limitations apply to the respective setting items. 

(1) When the sensor type is set to DC, the HPF setting for that channel must be 

OFF, and the input range of the DA-20 must be 1 V or higher. 

(2) The LPF setting must be lower than the frequency range setting. 

(3) When the trigger signal type is set to “Level”, the trigger channel may not 

be set to OFF. 

(4) When the frequency range setting is lower than 1 kHz, the Voice memo func-

tion must be OFF. 

3. Write the settings to the CompactFlash card. 

Access the menu bar on this screen, select [File] and [File Save].
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Other Information
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Specifi cations

Operating environment requirements

Computer Intel Pentium IV 2 GHz or equivalent CPU, CD-ROM drive, IBM PC/AT 

compatible architecture

RAM 512 MB or more (when handling WAV fi les 1 GB or larger, installed RAM 

should be 2 GB or more)

Hard disk 10 GB or more of free space

Display Suitable resolution for operating system (1024 × 768, XGA), or equiva-

lent

Operating system (One of the following)

Microsoft Windows 2000 Professional

Microsoft Windows XP Professional

(Support for Japanese and English)

Other requirements 

CompactFlash card slot, speakers, sound card 

Media type CD-ROM install disc (1)
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PCM Format WAVE Files

The WAVE fi le format represents a commonly used method developed for saving and playing 

music on Microsoft operating systems (such as Windows XP). WAVE fi les employ a format 

called RIFF which encodes information in multiple chunks that are linked and saved as a 

fi le.

The chunk confi guration used by the DA-20 is as follows.

RIFF chunk: This is always located at the beginning of the WAVE fi le and is 

called the RIFFHeader. Including DA-20 specifi c chunks, the fol-

lowing fi ve sub chunk types are comprised in the RIFF chunk.

fmt sub chunk: Data attributes (data format, sampling frequency, etc.)

rion sub chunk: DA-20 specifi c information (recording conditions etc.)

memo sub chunk: DA-20 specifi c information (voice memo/marker data added dur-

ing recording)

paus sub chunk: DA-20 specifi c information (pause data added during recording)

data sub chunk: Waveform data

The confi guration of each (sub) chunk is explained below.

The variable types used in the table are as follows.

WORD: 16-bit unsigned integer

DWORD: 32-bit unsigned integer

double: IEEE double precision fl oating

char: Character string

The little-endian principle is used when storing multi-byte values in memory.

RIFF chunk

Number
of bytes Type Description

4 char “RIFF”

4 DWORD Chunk size (in bytes)

4 char “WAVE”
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fmt sub chunk

Number
 of bytes Type Description

4 char “fmt”

4 DWORD Chunk size (in bytes): 16

2 WORD Data format: 1 (PCM)

2 WORD Channel number: 1 to 4

4 DWORD Sampling frequency

4 DWORD Number of data bytes per second (all channels)

2 WORD Number of bytes per data: channel number × 2

2 WORD Number of bits/data channel: 16

rion sub chunk (DA-20 specifi c)

Number
 of bytes Type Description

4 char “rion”

4 DWORD Chunk size (in bytes): 460

460 STRUCTURE Recording parameters and other information of DA-20

memo sub chunk (fi xed to 40 kB, DA-20 specifi c)

Number
 of bytes Type Description

4 char “memo”

4 DWORD Chunk size (in bytes): 1024 × 40 - 8 = 40952

40944 STRUCTURE
Recording voice memo or marker information

MEMORECTIMEFORMAT × 3412 = 40944

8 BYTE For adjusting overall sub chunk size to 40 kB

paus sub chunk (fi xed to 40 kB, DA-20 specifi c)

Number
 of bytes Type Description

4 char “paus”

4 DWORD Chunk size (in bytes): 1024 × 40 - 8 = 40952

40944 STRUCTURE
Recording pause information

MEMORECTIMEFORMAT × 3412 = 40944

8 BYTE For adjusting overall sub chunk size to 40 kB
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data sub chunk

Number
 of bytes Type Description

4 char “data”

4 DWORD Waveform data size (in bytes)

n STRUCTURE Waveform data

Even if no voice memo/marker information and pause information is recorded in the memo 

sub chunk and paus sub chunk, the size will be 40 kB respectively. The TIMEDATA will 

consist of voice memo/marker or pause information units (MEMORECTIMEFORMAT 

and PAUSETIMEFORMAT). 

MEMORECTIMEFORMAT and PAUSETIMEFORMAT are defi ned as follows. 

MEMORECTIMEFORMAT (DA-20 specifi c)

Number
 of bytes Type Description

4 DWORD
Voice memo/marker position. Indicates the position in bytes from the start 

of DATA.

4 DWORD Voice memo size (in bytes). For marker, this is zero.

4 DWORD

Voice memo/marker start time/time

D31 to D26 Adding 2000 gives the year

D25 to D22 Month

D21 to D17 Day

D16 to D12 Hours

D11 to D6 Minutes

D5 to D0 Seconds

Dxx such as D31 to D0 denotes position of bit.

PAUSETIMEFORMAT (DA-20 specifi c)

Number
 of bytes Type Description

4 DWORD Pause position. Indicates the position in bytes from the start of DATA.

4 DWORD

Pause start time

D31 to D26 Adding 2000 gives the year

D25 to D22 Month

D21 to D17 Day

D16 to D12 Hours

D11 to D6 Minutes

D5 to D0 Seconds
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WAVE fi le data in the DA-20 are fi xed to 16 bit. The data sequence according to the number 

of channels is as follows.

For 1 channel (same as 16-bit monaural)

sample1 sample2 sample3 sample4 · · ·

ch-n1 data ch-n1 data ch-n1 data ch-n1 data · · ·

For 2 channels (same as 16-bit stereo)

sample1 sample2 · · ·

ch-n1 data ch-n2 data ch-n1 data ch-n2 data · · ·

For 3 channels

sample1 · · ·

ch-n1 data ch-n2 data ch-n3 data · · · · · ·

For 4 channels

sample1 · · ·

ch-n1 data ch-n2 data ch-n3 data ch-n4 data · · ·
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RIONFORMAT (fi xed to 460 bytes, DA-20 specifi c)

Order Number 
of bytes Type Description

000 4 DWORD Maker name: “RION”

004 8 char Product type: spaces if empty

012 4 DWORD Device ID: Integer value

016 4 DWORD File version: 1 to

020 8 char CPU version: *.*.***

028 8 char DSP version: *.*.***

036 8 double Channel unit A/D conversion measurement amount 

(the product of this value and the A/D conversion value is the measurement 

amount) (DATA of data chunk is the A/D conversion value) 

When OFF, the value is zero.

036: Ch.1, 044: Ch.2, 052: Ch.3, 060: Ch.4

044 8 double

052 8 double

060 8 double

068 8 double 1Vpk measurement amount of each channel 

(corresponds to EU value, sensor sensitivity, etc.) 

When OFF, the value is zero, 1 without calibration

068: Ch.1, 076: Ch.2, 084: Ch.3, 092: Ch.4

076 8 double

084 8 double

092 8 double

100 8 char Left-aligned measurement amount

Blanks are padded with spaces.

“m/s2”, “EU”, “dB”, “V”

OFF settings are all “ ”(space)

100: Ch.1, 108: Ch.2, 116: Ch.3, 124: Ch.4

108 8 char

116 8 char

124 8 char

132 8 char Left-aligned input range (before 1Vpk calibration)

Blanks are padded with spaces. 

“1V”, “0.01V” etc.

132: Ch.1, 140: Ch.2, 148: Ch.3, 156: Ch.4

140 8 char

148 8 char

156 8 char
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Order Number 
of bytes Type Description

164 4 DWORD Low-pass fi lter of each channel

0: OFF,

6: 100 Hz, 7: 500 Hz, 10: 1 kHz

164: Ch.1, 168: Ch.2, 172: Ch.3, 176: Ch.4

168 4 DWORD

172 4 DWORD

176 4 DWORD

180 4 DWORD
High-pass fi lter of each channel 

0: OFF, 10: 0.3 Hz, 15: 10 Hz

180: Ch.1, 184: Ch.2, 181: Ch.3, 188: Ch.4

184 4 DWORD

188 4 DWORD

192 4 DWORD

196 4 DWORD
Trigger type

10: Level, 40: External, 50: External Gate

200 4 DWORD
Trigger mode

10: Free, 20: Single, 30: Repeat

204 4 DWORD Always 0

208 4 DWORD Trigger channel: 1 to 4

212 8 double Trigger level: unit is %

220 4 DWORD Pre-trigger: Seconds unit (equals pre-time)

224 4 DWORD Always 0

228 16 char

Recording start time: YyyyMmDd HhMmSs0

(space between d and H)

Example: 

2005/06/28, 8:30 is “20050628 0830000”

244 2 WORD

Overload incidence during recording in each channel

0: no, 1: yes

246 2 WORD

248 2 WORD

250 2 WORD

252 32 char

Comment string for each channel

Used by Waveform Analysis Software DA-20PA1

284 32 char

316 32 char

348 32 char

380 4 DWORD Number of pause incidences during recording: 0 to

384 4 DWORD Always 0

388 2 WORD CCLD information for each channel

0: DC/AC 

1: CCLD 

2: CHG (using VP-80)

390 2 WORD

392 2 WORD

394 2 WORD
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Order Number 
of bytes Type Description

396 8 double

EU value for 0 dB in each channel 

Zero when no dB conversion is carried out

404 8 double

412 8 double

420 8 double

428 2 WORD

Voice memo setting

0: OFF (Marker), 1: Voice Only, 

2: Voice/Input

Zero when no voice memo data are present with Voice/Input setting 

430 4 DWORD

Input setting information

0: OFF, 1: AC, 2: DC,

3: CCLD, 4: reserved,

5: CHARGE

D15 to D12 Using above code for channel 4

D11 to D8 Using above code for channel 3 

D7 to D4 Using above code for channel 2 

D3 to D0 Using above code for channel 1

434 4 DWORD Serial number

438 2 WORD
Number of trigger incidences

Repeat trigger sequential number (0 to)

440 2 WORD No. of voice memo or marker recordings

442 18
Indetermi-

nate
----
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About the Calibration Function
(Read-out Conversion)

Basic relationship between physical quantity of 
measurement object and recorded data

A sensor produces a voltage (electrical signal) in response to a change in the physical quantity 

acting upon it. However, when the sensor is changed to one with a different sensitivity, the 

output voltage will also change signifi cantly, even if the physical quantity remains the same. 

Therefore sensors usually come with individual documentation stating the sensitivity of the 

sensor in response to a given physical quantity. Some examples are given below. 

Examples

Accelerometer with built-in preamplifi er 6.42 mV/(m/s2) 

When the normal acceleration unit of 1 m/s2 is applied to this sensor, it will 

produce a voltage of 6.42 mV. 

Microphone  -28 dBV/Pa 

When the normal sound pressure unit of 1 Pa is applied to this sensor, it will 

produce a voltage of -28 dBV = 0.04 V. 

When the sensor sensitivity is known, the sensor output can be used to calculate the physical 

quantity acting on the sensor according to the following equation: 

Physical quantity = (1/sensor sensitivity) × voltage 

Instead of sensor sensitivity, this software uses a coeffi cient called “Calib. (Unit/Volt)” 

which is the reciprocal expression of sensor sensitivity. The above equation therefore can be 

restated as follows. 

Physical quantity = (1/sensor sensitivity) × voltage = “Calib. (Unit/Volt)” × voltage

Measurement
object

Physical
quantity

Sensor

Sensor
sensitivity

Voltage
(Electrical signal)

DA-20

Input range

A/D conversion
value

Recorded data
+ DA-20 original information

(WAVE file)

Physical quantity = (1/sensor sensitivity) x Voltage
= "Calib. (Unit/Volt)" x Voltage
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The voltage output by the sensor is then input to the DA-20. The DA-20 performs A/D con-

version using the “input range/25400” voltage as 1 unit. The voltage output by the sensor 

can be calculated according to the following equation.

Voltage = (input range/25400) × A/D conversion value

Measurement
object

Physical
quantity

Sensor

Sensor
sensitivity

Voltage
(Electrical signal)

DA-20

Input range

A/D conversion
value

Recorded data
+ DA-20 original information

(WAVE file)

Voltage = (input range/25400) x A/D conversion value

The physical quantity can be calculated from the conversion value stored in the fi le as fol-

lows.

Physical quantity = “Calib. (Unit/Volt)” × voltage 

= {“Calib. (Unit/Volt)” × (input range/25400)} × A/D conversion value

In this software, the {“Calib. (Unit/Volt)” × (input range/25400)} part is called “Calib. 

(Unit/bit)”. Using this, the above equation becomes

Physical quantity = “Calib. (Unit/Volt)” × voltage 

= “Calib. (Unit/bit)” × A/D conversion value

The “Calib. (Unit/bit)” is a useful value for converting the WAVE fi le data (A/D conversion 

values) into the corresponding physical quantity.

Measurement
object

Physical
quantity

Sensor

Sensor
sensitivity

Voltage
(Electrical signal)

DA-20

Input range

A/D conversion
value

Recorded data
+ DA-20 original information

(WAVE file)

Voltage = (input range/25400) x A/D conversion value

Physical quantity = (1/sensor sensitivity) x Voltage
= "Calib. (Unit/Volt)" x Voltage

Physical quantity = "Calib. (Unit/bit) " x A/D conversion value
= "Calib. (Unit/Volt)" x (input range/25400) x A/D conversion value
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WAVE fi les recorded with the DA-20 contain the original information (sensor sensitivity, 

input range, A/D conversion 1 unit voltage (= input range/25400). Therefore the measure-

ment data can be read as A/D values or as voltage or as the physical quantity that was the 

measurement object.

WAVE fi les not recorded with the DA-20 do not have information about input range, A/D 

conversion 1 unit voltage etc. Therefore the measurement data can only be read as A/D 

values.

Measurement
object

Physical
quantity

Sensor

Sensor
sensitivity ?

Voltage
(Electrical signal)

A/D converter
board or similar

Input range ?

A/D conversion
value

Recorded data
(WAVE file)
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Readout change of recorded data

I. Changing the way data are displayed

Selecting the cursor value unit 
After A/D conversion, data recorded with the DA-20 can be read as voltage or as the 

physical quantity that was the measurement object.

The [Unit] selection menu on the [Calc. Setting] tab of the setting panel gives access to 

settings for the cursor value reading. This setting can be made separately for each channel. 

The following selections are available.

None: The A/D conversion value is shown.

V (Volt): The voltage value is shown.

Pa, m/s2, V, EU etc.:

The physical quantity is shown.

The DA-20 supports only the following four physical quantities 

as unit names for the third selection: Pa, m/s2, EU, V. Due to 

this limitation, the software allows converting the V and EU 

values into the original unit names.

However, the maximum length of a unit name is 7 characters.

The unit name change is available on the [Wave File &Info] screen.

For details, see the section “Changing the unit name” in “II. Measurement value readout 

conversion” on page 90. Because the unit name change also involves the Calib. (Unit/Volt), 

you should also read the other explanations in “II. Measurement value readout conver-

sion”.

Important 
For fi les that are to be played back on the DA-20, do not change 
the unit name. Otherwise correct playback will not be pos-
sible.
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Displaying a waveform as RMS
RMS is calculated from the waveform and displayed according 

to the time constant setting. The RMS display can be activated 

by selecting the [Show RMS] check box in the [Calc. Setting] 

tab.

When switching to RMS display, the dB waveform derived from 

RMS is shown. To show the RMS value as a waveform, deselect 

the [dB] check box.

The dB value is calculated as follows.

dB value = 20 log (RMS value (physical quantity value)/dB Reference)

The default setting for the dB Reference is “1”, but this can be changed on the [Wave File 

&Info] screen. For details about the dB Reference, see “Changing the dB Reference” 

(page 89) in “II. Measurement value readout conversion”.

The time constant can be selected from 1 msec, 10 msec, 35 msec, 

FAST (125 msec), 630 msec, and SLOW (1 sec). 

However, the time constant cannot be shorter than 1/2 of the 

sampling interval (reciprocal expression of sampling frequency). 

When the time constant is changed during RMS display, RMS 

recalculation is performed.

Original waveform

RMS check box

dB waveform derived from RMS

dB check box

RMS waveform display
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II. Measurement value readout conversion
If data were recorded on the DA-20 without correct sensor sensitivity and EU settings, the 

correct physical quantity can normally not be displayed from the resulting WAVE fi le. 

To solve this problem, the DA-20PA1 offers a function for changing the Calib. (Unit/Volt). 

The calib. (Unit/Volt) is the reciprocal expression of sensor sensitivity. For reasons of simplic-

ity, the 0 dB reference value required for dB calculation is fi xed to 2E-5 Pa (sound pressure 

0 dB) at the DA-20. Physical units other than sound pressure or acceleration are expressed 

as EU or V.

To augment the control fl exibility of the DA-20, the software offers the capability for expressing 

physical quantities using the original unit names, with a 0 dB reference value as required.

Changing the “Calib. (Unit/Volt)”
The “Calib. (Unit/Volt)” is the reciprocal expression of sensor sensitivity. By multiplying 

it with the voltage value derived from the data, the physical quantity is obtained.

Physical quantity = Calib. (Unit/Volt) × voltage

When the Conv. Unit on the [Calc. Setting] tab of the setting panel is set to “V” (Volt), the 

cursor readout value (voltage) multiplied with the Calib. (Unit/Volt) matches the cursor 

readout when the unit is set to the physical quantity.

The Calib. (Unit/Volt) can be changed on the [Wave File &Info] screen. There are two 

methods (method A and method B) for achieving this. The Calib. (Unit/Volt) setting can 

be made separately for each channel.

Method A “Calib. (Unit/Volt)” text box

Method B Calib. (Unit/Volt) is made from data: XX.X [dB] from waveform 

data RMS/maximum value

Method A

Method B
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Method A is suitable when sensor sensitivity is known. Enter the Calib. (Unit/Volt) into 

the respective text box. 

Method B is suitable when the calibration signal is included in the recorded data. Also 

when sensor sensitivity is known, it is recommended to include a calibration signal in the 

recorded data, for later use. Use the calibration signal waveform range as analysis range 

and enter the RMS value or maximum value of that waveform in dB. If the calibration 

signal value is known only as RMS, use this as Y and enter 20logY as XX.X dB. The 

result of calibration using this method will be shown in the “Calib. (Unit/Volt)” text box 

of method A. 

Finally, click [Overwrite] and [Apply] or [OK] to accept the Calib. (Unit/Volt) change. To 

abandon the change, click the [Cancel] button. (If the button is grayed out and cannot be 

clicked, move the mouse cursor to a position outside of the input fi eld and click.)

The button functions are as follows. 

[Overwrite] Enable the change and update the WAVE fi le. 

[Apply] Enable the change. 

[OK] Enable the change and close the screen. 

[Cancel] Abandon any steps taken since the last overwrite or apply action, 

and close the screen.
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Changing the dB Reference
The RMS waveform display, FFT analysis result display, and octave-band analysis result 

display can be switched to dB. The dB value is calculated from the original data as fol-

lows.

dB value = 20log (data value/0 dB reference value)

The dB value can be calculated with any 0 dB reference value, but for certain kinds of 

measurement, standards and industry conventions may require a particular value. For 

example, sound pressure level requires a 0 dB reference value of 2E-5 [Pa].

The 0 dB reference value can be set by entering the value into the [dB Reference] text box 

on the [Wave File &Info] screen. The setting can be made separately for each channel.

After making the entry, click [Overwrite] and [Apply] or [OK] to accept the change. To 

abandon the change, click the [Cancel] button. (If the button is grayed out and cannot be 

clicked, move the mouse cursor to a position outside of the input fi eld and click.)

The button functions are as follows.

[Overwrite] Enable the change and update the WAVE fi le.

[Apply] Enable the change.

[OK] Enable the change and close the screen.

[Cancel] Abandon any steps taken since the last overwrite or apply action, 

and close the screen.
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Changing the unit name
Data that were recorded as EU or V due to restrictions imposed by the DA-20 can be 

changed into the units such as for temperature (deg.), rotation speed (rpm), or wind speed 

(m/sec).

The change in unit name is immediately refl ected in the waveform display Y axis.

To change the unit name, enter the name into the [Conv. Unit] text box on the [Wave File 

&Info] screen. The setting can be made separately for each channel. The maximum length 

is 7 characters.

After making the entry, click [Overwrite] and [Apply] or [OK] to accept the change.

To abandon the change, click the [Cancel] button. (If the button is grayed out and cannot 

be clicked, move the mouse cursor to a position outside of the input fi eld and click.)

The button functions are as follows.

[Overwrite] Enable the change and update the WAVE fi le.

[Apply] Enable the change.

[OK] Enable the change and close the screen.

[Cancel] Abandon any steps taken since the last overwrite or apply action, 

and close the screen.
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An example for a change in Conv. Unit is shown below.

[Unit] menu:
physical quantity unit name is "V"

Physical quantity unit display is changed
from V to deg.

[Overwrite], [Apply]
or [OK] is clicked

[Unit] menu:
physical quantity unit name has changed from "V" to deg.

Unit name change
V deg.
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Reference information for changing the “Calib. (Unit/Volt)”

Relation between DA-20 setting, Calib. (Unit/Volt), and unit name

The relation between the “Sensor” and “Sensitivity” settings on the <Calibration> menu of 

the DA-20 and the Calib. (Unit/Volt) and unit name used by this software is as follows.

EU
Calib. (Unit/Volt) = X X is value entered as “Sensitivity”

Unit name = EU

MIC
Calib. (Unit/Volt) = 10^(-S/20) S is microphone sensitivity entered as “Sensitiv-

ity”

Example: UC-53A

Calib. (Unit/Volt) = 2.7542E+01

S = -28.8 dBV/Pa (incl. preamplifi er NH-22 pass-through loss)

Unit name = Pa

PICK or CHG
Calib. (Unit/Volt) = 1000/X X is value entered as “Sensitivity”

Examples

PV-90I Calib. (Unit/Volt) = 2.2727E+03 X = 0.44 mV/(m/s2)

PV-85 + VP-80 Calib. (Unit/Volt) = 1.5576E+02 X = 6.42 pC/(m/s2)

Unit name = m/s2

V
Calib. (Unit/Volt) = 1 Sensitivity = “--” (no input)

Unit name = V
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Practical examples for changing Calib. (Unit/Volt)

Recording AC output signal of sound level meter on DA-20

In this example, not only the microphone but the entire sound level meter is treated as a 

sensor.

Rion sound level meters are designed to output a voltage of 1 [Vrms] at the full-scale point 

of the respective level range. This means that the sensor (sound level meter) sensitivity is 

1 [Vrms]/level range [dBPa (rms)].

Note that the sensor sensitivity changes according to the level range setting of the sound 

level meter.

A sound pressure level of 0 dB equals 2 × 10-5 [Pa (rms)], therefore X [dBPa (rms)] cor-

responding to the level range [dBPa (rms)] can be calculated according to the following 

equation.

Level range [dBPa (rms)] = 20log (X [Pa (rms)]/2 × 10-5 [Pa (rms)])

= 20log (X [Pa (rms)]) + 94.0* [dBPa (rms)]

X [Pa (rms)] = 10^ ((level range - 94.0*)/20) [Pa (rms)]

From the above, the sound level meter sensitivity is as follows.

Sensor sensitivity = 1/10^((level range - 94.0*)/20) [Vrms/Pa (rms)]

= 1/10^((level range - 94.0*)/20) [V/Pa]

Therefore, the Calib. (Unit/Volt) is as follows.

Calib. (Unit/Volt) = 10^((level range -94.0*)/20) [Pa/V]

Output voltage
1.0 Vrms

Sound pressure level corresponding
to level range full-scale Sound level
meter

Sound level meter

100 dB sound pressure level

= 2.0 [Pa (rms)]

Sound level meter

Level range = 100 dB
Output voltage

1.0 Vrms
Calib. (Unit/Volt)

= 2.0 [Pa/V]

110 dB sound pressure level

= 6.325 [Pa (rms)]

Sound level meter

Level range = 110 dB
Output voltage

1.0 Vrms
Calib. (Unit/Volt)

= 6.325 [Pa/V]

120 dB sound pressure level

= 20.0 [Pa (rms)]

Sound level meter

Level range = 120 dB
Output voltage

1.0 Vrms
Calib. (Unit/Volt)

= 20.0 [Pa/V]

For example, when the sound level meter is set to a 100 dB range, the Calib. (Unit/Volt) 

for measured sound pressure level data is as follows. 

Calib. (Unit/Volt): 100 dB range = 10^((100 - 94.0*)/20) [Pa/V] = 2.0 [Pa/V] 

* Note: The “94.0” value is actually 93.9794... (= 20log(2 × 10-5))
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Example for recording AC output signal of sound level meter on DA-20

(calibration signal output added to actual data)

Using the calibration signal output of the sound level meter for calibration of externally 

connected equipment, the Calib. (Unit/Volt) can be determined.

At the level range setting to be used for recording, output the calibration signal for a few 

seconds, and then start the actual data recording. The voltage of the calibration signal is 

always 0.5 Vrms at any level range setting. On the other hand, the AC output level at sound 

pressure corresponding to the full-scale point is 1 Vrms. Therefore the calibration signal 

can be said to be the equal of measuring sound with one half the energy of the full-scale 

sound pressure level (level range - 6.0 dB).

Sound level meter Calibration signal
0.5 Vrms

Sound level meter Output voltage
0.5 Vrms

Sound pressure level corresponding
to level range - 6.0 dB

Calibration signal

Sound pressure level corresponding
to level range - 6.0 dB

Recorded data

Select the check box and select RMS

In the example described above, the Calib. (Unit/Volt) should be set so that the RMS value 

during the calibration signal interval is “level range - 6.0 dB”. 

The easiest way to achieve this is to use method B described in the section “Changing the 

“Calib. (Unit/Volt)”” of “II. Measurement value readout conversion” (page 87). 
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Display of data measured with NA-28 (NX-28WR)
Data measured with the NA-28 (NX-28WR) can be loaded and displayed using the DA-20PA1 

software. The fi le information for such data has the following special characteristics.

When displaying level information for such data, set the graph display unit to Pa, and select 

the check boxes for Show RMS and dB.

Conversion unit information for level range is recorded.

Level range of NA-28 (NX-28WR)
is shown.

Due to the sound pressure level definition,
this is always 2E-5.
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Troubleshooting

This section lists possible problems that may occur when using the software, as well as steps 

to take in such a case. When you encounter a similar problem, try the countermeasures de-

scribed here.

If the problem persists also after taking the described steps, or if a problem not described 

here occurs, contact the supplier.

Symptom Screen layout is corrupted. Controls cannot be selected 

without scrolling.

Countermeasure This condition may occur when “Large Font” is specifi ed as system 

font. Specify “Small Font”.

(For information on how to set the system font, refer to the documen-

tation of the operating system.)

Symptom On the FFT analysis screen, after moving the FFT analysis 

graph, the cursor can no longer be moved.

Countermeasure When the range where data exist is moved out of the graph, the cursor 

cannot be moved. In such a case, hold down the left mouse button and 

drag the graph from right to left to reset the zoom/move condition.

Symptom Octave-band analysis was attempted, but the message 

“Cannot perform octave-band analysis for this fi le (Invalid 

Sampling Frequency)” appears.

Countermeasure 1 Check whether the sampling frequency of the WAVE fi le is outside 

the range supported by this software. For information on limitations, 

see the section “Precautions” (page vi).

Countermeasure 2 Check whether the fi les “fi lecoef1.csv” and “fi lecoef3.csv” are located 

in the install folder (default: “C:\Program Files\RION\DA-20PA1”). 

If these fi les are not present, uninstall the software and then install 

it again.
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Symptom When trying to start the software, the normal screen does 

not appear, and the message “Invalid fi le...” is shown.

Countermeasure Check whether the software was installed on the computer where 

you are starting it. A message such as “Invalid fi le...” will appear if 

attempting to start the software from another computer on a network, 

and the software will not operate correctly. Be sure to install the 

software on the computer from which it will be used.
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